form•Z v9.1.0 (#A399) Change log
What’s New
Support for OS X 11 (Big Sur) and machines using Apple Silicone (using Rosetta 2).
“Auto Select Multi View” is a new option in the “Window” pull-down menu. When
enabled, the active frame of a multi view display is automatically selected as the mouse
enters the frame. When disabled (which is the default), a mouse click in the desired
frame is required to make it active (as with v8 and earlier versions).
General
The screen now updates properly during RenderZone image now updates properly
during rendering.
Hidden Line rendering progress bars have been improved.
Material previews do not re-render in Material parameters palette when changing the
active material.
Section tool now works properly when 2 Click Face/Outline Selection is enabled.
Guide Snap works better under certain situations when the grid snap is also enabled.
Edit Cone of Vision no longer resets Undos.
Edit Cone of Vision behaves properly after “Reset All Workspaces” and Importing
workspaces.
Measurement tools no longer leave artifacts on the screen.
The Working units Angle option for Positive Angle Direction works using Clockwise as
expected.
SKP import handles files that contain improper material names.
Undo after a Symmetry operation works as expected.
In Project Settings->Appearance, the previews for project color schemes now display
properly.
In palettes with groups, Collapsing/Expanding a selected group now works as expected.
No longer caught in an loop when 2 materials have the same name.
Changing the display mode back to Shaded or Wireframe after RenderZone now works
properly.
The Shaded render “Fit In Window” background option now work properly.
Collada translator (DAE) now handles files that contain discreet face colors (common in
files created by Artios CAD).
Various performance, localization and stability improvements.

Macintosh
Hiragana character entry behaves as expected.
LWO export now works properly.
Windows
Items can be reordered in nested palettes as expected.
Palettes in Palette Dock can be nested in any order.
Layout
Certain Dimensions now display as expected when zoomed in close.

Earlier versions……
form•Z v9.0.6.1 (#A286) Change log
General
Certain .fmz file contain reference objects now open as properly.
The “X” field of the input palette is no longer active at unexpected times.
Macintosh
Cut/Copy/Paste now works in palettes with list of names (Objects, Layers etc..).
form•Z v9.0.6 (#A283) Change log
New stuff
SKP translator updated to import/export SketchUp 2020 files. Plus:
Import performance significantly improved.
Objects will be surfaces by default unless “Construct Solids” is enabled (which is
now on by default for new installations).
Import now maintains layers and materials properly.
Non-Roman characters file names now supported for import and export.
Japanese characters in layer name and Material names are now supported.
Import now includes wire objects.
Exporting files with metric units works as expected.

General
Contour Sections no longer affected by manipulating corresponding Transform
Controller
Conflicts resolved that would cause Key Shortcuts to stop working.
Arc 3 can be inverted with the CMD/Ctrl (Mac/Win) key.
Objects created by Duplicate (Edit menu) remain selected.
Reference Files window displays correct name.
DXF export and import now supports Non-Roman characters in the file name.
Exporting DAE and KMZ files works properly
Windows
Check for Update works as expected no on systems with certain Windows settings.
Alt key tap key works as expected
Draft Layout
Grid Snap now works as expected when combined with the Guide snap
Python scripting
unfold.py script now works as expected.
Scripts are maintained in the Extensions menu and are sorted properly.
The getLayer() and setLayer object method has been improved.
form•Z v9.0.5(#A12A) Change log
form•Z v9.0.4(#A12A) Change log
New stuff
“Dynamic” is a new option in the Extend Segment tool options. When selected, the
extension is made dynamically using the projection of the cursor position onto the
tangent from the end of the object.
General
Components with Flat/Cubic/Spherical decal controls now render properly in
RenderZone.
Save a Copy as to v8.x now works properly for files with embedded components.

The objects palette is now updated properly after Components are exploded.
Changing the name of a view or layer to an existing name, no longer leads to repeated
messages about the duplicate name.
The fillet tool is applied to the selected point for certain objects.
Import from Drafting now groups the imported objects properly.
Exiting the Cone of Vision, no longer disturbs the palettes under certain conditions.
Certain Sub-d tools no longer automatically apply unintended symmetry
Draft/Layout
Frames are now properly updated when the linked Model file is changed.
The title blocks folder is selected by default when choosing a title block.
The offset outline tool now works properly on closed shapes.
The Image and Image fit tools now track the cursor properly when placing images.
Python scripting
Python scripts now work properly on some Windows 10 machines that previously did
not recognize Python.
A new method (material) has been added to the “face” object to retrieve the material
assigned to the face (face.material).
The “object” method getLocalOrigin()now returns the proper value
fz.pickList() now returns a valid empty list when nothing is picked.
fz.viewList(), fz.materialList() and fz.lightList() now returns a valid empty list when the
project does not contain any of the respective objects.
fz.revolve() angle parameter now works properly.
Object methods edgeCount(), edge(), edgeList() now work as expected.
A number of sample scripts have been updated.

form•Z v9.0.3(#A123) Change log
New stuff
“Superimpose” is a new option in the Underlay options of the Reference Plane
Parameters palette. When selected, the underlay is Superimposed in shaded views
instead of depth sorted. This is most useful when combined with the transparency slider
to see the undelay image through a shaded image.
“Give Guide Snaps Priority” is a new option in the snap options Palette. When selected,
Guide Snaps are given priority over object snaps (when both are enabled). That is if the
cursor is close to both a guide and a snappable point/edge/face, the location will be
snapped to the guide rather than the point/edge/face. When this option is disabled, the
opposite rule is applied. This option is now on by default by popular request as it makes
the guides more functional in shaded rendering modes. The option can be controlled
with a key shortcut as well (Key Shortcuts manager).
General
Export of hidden line images to pixel based formats (TIFF/PNG/JPG etc.) now works
properly.
Underlay images no longer disappear when switching from wireframe to shaded full and
the back to wireframe on machines with certain graphics cards.
Components with Flat/Cubic/Spherical texture map controls now render properly in
RenderZone.
Using Reduce Mesh tool no longer crashes on certain objects.
Files with mirrored components now show the components properly when saving and
re-opening the file.
Curve and Surface Formula tools mow show all the formulas in the Interface
View navigation in the Decals and Classic Texture Map dialog now works properly.
The “Pick By” and “Assign” options in the Classic Texture Map dialog now work properly.
Door/Window components are now are placed at the proper depth.
The Section tool now properly honors the Status of objects (Ghost or Delete).
Windows specific
The Transform tool no longer crashes when entering a second value for the Scale
option.
Draft/Layout

Printing or exporting to PDF no longer misses some elements.
Printing or exporting to PDF now includes title blocks properly.
Printing from draft space now works as expected.
Image elements no longer have a border when printed or exported to pdf.
The Layout content tools no longer become randomly dimmed.
Layout frames now update properly when the model is changed.

form•Z v9.0.1(#A107) Change log
General
When the favorites menu is invoked (Space bar by default), pressing the space bar again
will open and position the tool options palette on the screen at the location of the
favorites tools. This makes for an easy way to access the Tool Options without needing
to navigate to the location of the palette. The palette is returned to its original state
when the mouse moves out of the newly positioned tool options palette or the favorites
menu shortcut is selected again.
Pop-up Tool Options is a new key shortcut available in the Palettes group of the Key
shortcuts manager. This invokes the tool options at the mouse location as with the
favorites menu without needing to go through the favorites menu first. There is no
default key combination assigned for this option.
The color popup in the Attributes tab of the Inspector now works properly when clicking
on the arrow indicator.
Export PSD no longer generates empty files under certain situations.
The palette dock is now maintained in the Cone Of Vision environment.
Shaded work and shaded full now show the proper color when Copy and paste of
objects which have materials with matching names.
Certain geometry no longer causes a crash when using object snaps and the mouse rolls
over the object.
Create Reference File no longer includes references to other attached reference files in
the newly created reference file.
Create Reference File now warns when replacing a reference file that is already being
referenced by the project.
Create Reference File now handles single object reference files properly.
Docking and undocking certain palettes now works properly.
Editing Components in the project window has been improved.
The parameters tab of the inspector now works properly with components.
Components placed with the “Place on Active Layer” option now explode properly.
The “Getting Started” tutorials are now accessible from the startup screen again.
Holding CMD and dragging docked palette will allow precision
placement/force placement
OS X specific
Installer now works better on OS X 10.15.3
Animations played in the form•Z window now display properly.

Closing the Inspector palette, no longer leads to crashes.
Changing the direction of the Arc 3 again works with tapping command key.
Windows specific
Hide palettes no longer leads to extra margins shown around the palettes when unhiding.
Draft/Layout
Title blocks now work as expected.
The place image tool now works as expected.
Components update properly when a layout file is opened.
Paste from Model/Paste from Draft have been improved.
Compounds from v6 files are now converted properly.
form•Z v9.0.0.3(#A0F0) Change log
General
The on-line manual has an updated interface including and better Index and search
features and loads properly from the application.
The Action palette shows the active tool as expected.
The “Keep Proportional” option now works properly in the place component tool and
the Component parameters of the Inspector palette.
Editing object names that are inside groups in the objects palette now show in the
proper locations.
Resizing a palette while editing a text field no longer causes top edit field to move to the
wrong location.
A detached Modeling tool palette can now be reinserted in the dock by dragging the
palette such that the cursor inside the dock while pressing the Command (Mac OS) or
ctrl (Windows) key.
Preview renderings for RenderZone or V-Ray for form•Z no longer hang or crash when
clicking in the Materials or Material parameters palette before the preview rendering is
complete.
Windows Specific
The icon for “Delete Component” and “Delete Library” now shows properly.
Drag and drop now works properly in the Objects palette.

OS X specific
Switching to another application and back to form•Z when there is more than one
project open, no longer switches she active project.
the “options” button in the export file dialog no longer crashes on 10.14 and later.
Draft Layout
Import from Modeling now available in File menu of Draft Layout app. This converts the
model to drafting space using the current view or optional parameters defined in the
new Import from Modeling options.
Import from Drafting now available in Modeling app imports the drafting space of a .fml
file onto the current reference plane of the model.
Title blocks now show properly after loading a layout file.
Switching between layout and Draft spaces refreshes the window properly.

